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NEW QUESTION 1
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a query named Queryl that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved by the query is shown in the following table.

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

Solution: You select the UserName and Location columns, and then you click Keep Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 2
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result these questions will not appear in the review screen.
You have an Excel workbook that contains a table named Table1. A sample of the data in Table1 is shown in the following table.

You need to create a PivotTable in PowerPivot as shown in the exhibit.
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Solution: You create a measure named Products the uses the CONCATENATEX DAX function. You add a PivotTable. You drag Products to the Rows field. You
drag Price to the Values field.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 3
You have the data model shown in the Data Model exhibit. (Click the Exhibit button.)
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You have the PivotChart shown in the Pivot Chart exhibit. (Click the Exhibit button.)

You need to change the current view of the PivotChart to display ProductCategory only. What should you do?

A. Double-click a bar in the PivotChart.
B. Click the - button.
C. Right-click the PivotChart and click Reset to Match Style
D. Right-click a bar in the PivotChart and click Expand Entire Field.

Answer: D

NEW QUESTION 4
You create an Excel workbook named SalesResults.xlsx. You create a workbook query that connects to a Microsoft SQL Server database and loads data to the
data model. You create a PivotTable and a PivotChart.
You plan to share SalesResults.xlsx to several users outside of your organization.
You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.
What should you do?

A. Run the Document Inspector.
B. Save the workbook as an Excel Binary Workbook (.xlsb).
C. From Query Editor, open the Data Source Settings and delete the credentials.
D. Modify the source of the query.

Answer: C

NEW QUESTION 5
You install Microsoft Power BI Publisher for Excel.
You need to use Excel to connect and analyze Power BI data.
To which two types of Power BI data can you connect? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. apps
B. datasets
C. reports
D. dashboard

Answer: BC

Explanation: 
Analyze in Excel is very useful for datasets and reports that connect to Analysis Services
Tabular or Multidimensional databases, or from Power BI Desktop files or Excel workbooks with data mo that have model measures created using Data Analysis
Expressions (DAX).
https://docs.microsoft.com/en-us/power-bi/service-analyze-in-excel

NEW QUESTION 6
You have a workbook query that gets a table from an Excel workbook. The table contains a column1. In the query, you configure Column1 to use a Data Type of
Whole Number.
You refresh the data and find several errors in Column1. You discover that new entries in the table contain nonnumeric characters.
You need to ensure that when the data is imported, any fields that contain nonnumeric values are set 1. What should you do from Query Editor?

A. Select the table and click Keep Errors.
B. Select the column and click Replace Values...
C. Select the column and click Remove Errors.
D. Select the column and click Replace Errors...

Answer: D

NEW QUESTION 7
Your company has a data analyst who uses Microsoft Power BI Desktop to create a data model and several reports.
The data analyst publishes the reports to the Power BI service.
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You need to create a PivotTable in Excel that uses the data model created by the data analyst. The solution must prevent the data from being imported into Excel.
What should you do first?

A. From powerbt.com, select the repor
B. From the File menu, click Save as.
C. From Excel, create a new query that uses the Data Catalog.
D. From powerbi.com, select the report From the File menu, click Download report.
E. From powerbi.com, select the report and click Analyze in Excel.

Answer: D

NEW QUESTION 8
You create the PivotChart shown in the exhibit. (Click the Exhibit button.) Exhibit:

In which area is Product and in which area is SalesAmount? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Product: Axis
Box 2: SalesAmount: Values

NEW QUESTION 9
You have a KPI named Goal that calculates the sales from the previous year and multiplies the sales by 1.1. You need to modify Goal to multiply the sales from
the previous year by 1.15.
What should you do?

A. From Power Pivot, modify the measure.
B. From the properties of the KPI, modify the KPI base field.
C. From Power Pivot, create a new calculated column, and then modify the KPI.
D. From the properties of the KPI, modify the absolute value.

Answer: A

NEW QUESTION 10
You need to create a PivotChart as shown in the exhibit. (Click the Exhibit button.) Exhibit:
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Which field should you use for each area? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

Legend: BrandName Axis: MonthName

NEW QUESTION 10
You have a pie chart.
You need the wedges of the pie chart to be separated as shown in the following exhibit.

A. Change the chart type to Pie of Pie.
B. Right-click the pie chart, click Expand/Collapse, and then click Expand.
C. Right-click the pie chart, click Expand/Collapse, and Then click Expand Entire Field
D. Select a wedge of the pie chart and then drag the wedge.

Answer: D

NEW QUESTION 15
You have an Excel workbook that contains a table named Sales. You add Sales to the Power Pivot model.
You need to set a column named TransactionID as the row identifier for the Sales table. What should you do?

A. From Power Pivot, modify the Table Behavior setting.
B. From Query Editor, add an index column.
C. From Query Editor, modify the Data Type.
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D. From Power Pivot, modify the Default Field Set.

Answer: A

Explanation: 
https://msdn.microsoft.com/en-us/library/hh560542(v=sql.110).aspx

 In the Data View of your PowerPivot Window, click the PowerPivot Window: Advanced Tab.
 Click the table tab at the bottom of the window to select the table for which you are configuring

properties.
 In Reporting Properties, click Table Behavior.
 Set the Row Identifier, and then proceed to specify other properties in this dialog.

Opening the Table Behavior dialog box https://ksdconsultancy.blog/2015/10/08/set-table-behaviour-in-powerpivot/

NEW QUESTION 18
You need to create a PivotChart that has a filter as shown in the following exhibit.

What should you do first?

A. From the model, create a measure.
B. From Query Editor, create a function.
C. From Query Editor, create a parameter.
D. From the model, create a hierarchy.

Answer: A

Explanation: 
References:
https://support.office.com/en-us/article/measures-in-power-pivot-86484821-a324-4da3-803b-82fd2e5033f4

NEW QUESTION 20
You import the data from two next files into a PowerPivot model to create two tables named Customers and Invoices. Each table contains a column named
CustomerID.
When you attempt to create a relationship between the Customers table and the Invoices table by using the CustomerID column from each table, the relationship
cannot be created due to duplicate CustomerID values.
You need to ensure that you can create the relationship. What should you do?

A. Add an index column to the Customers query
B. Add an index column to the Invoices query
C. Group the Customers query by CustomerID
D. Sort the Invoices query by CustomerID, and then add a Fill Down step

Answer: C

NEW QUESTION 25
You have a workbook query that loads data from C:\Data\Users.xlsx. You move Users.xlsx to a shared folder on the network.
You need to ensure that you can refresh the data from Users.xlsx. What should you do?

A. From the Linked Table tab in Power Pivot, modify the Update Mode.
B. From Query Editor, modify the Source step.
C. From the Insert tab in Excel, click My Add-ins, and then manage the add-ins.
D. From the Data tab in Excel click Connections, and then modify the properties of the connection.

Answer: D

NEW QUESTION 29
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result these questions will not appear in the review screen.
Your company has sales offices in several cities.
You create a table that represents the amount of sales in each city by month as shown in the exhibit.
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You need to ensure that all values lower than 250 display a red icon. The solution must ensure that all values greater than 500 display a green icon.
Solution: You modify the conditional formatting rule, and then set a new value for the yellow icon. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 31
You have an Excel workbook query that loads data to a worksheet and the data model. You need to ensure that the data is refreshed whenever you open the
workbook.
What should you do?

A. From the File tab, click Option, and then modify the Data option.
B. From the File tab, click Options, and then modify the General options.
C. From the Data tab, click Queries & Connections, and then edit the properties of the query.
D. From the Power Pivot model, modify the Table Behavior setting.

Answer: C

Explanation: 
https://support.office.com/en-us/article/refresh-an-external-data-connection-in-excel-2016-for-windows-152417

NEW QUESTION 33
Note: This question is part of a series of questions that use the same scenario, For your convenience is repeated in each question. Each question presents a
different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the Data Model exhibit.
Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.
You need to create a measure named [Sales Monthly RT] that calculates a running total of [Sales] for each date within a month as shown in the following exhibit.

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM [Sales], DATESMTD
The following sample formula creates a measure that calculates the 'Month To Date Total' for the Internet sales.
To see how this works, create a PivotTable and add the fields, CalendarYear, MonthNumberOfYear and
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DayNumberOfMonth, to the Row Labels
area of the PivotTable. Then add a measure, namedMonth To Date
Total, using the formula defined in the code section, to the Values
area of the PivotTable.
=CALCULATE(SUM(InternetSales_USD[SalesAmount_USD]), DATESMTD(DateTime[DateKey])) https://msdn.microsoft.com/en-us/query-bi/dax/datesmtd-
function-dax

NEW QUESTION 38
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.
You have an Excel workbook that contains a table named Table1. A sample of the data in Table1 is shown in the following table.

You need to create a PivotTable in PowerPivot as shown in the exhibit.

Solution: You create a hierarchy named Products that contains ProductCategory,
Solution: You create a measure named Products the uses the DataTable DAX Function. You add a PivotTable. You drag products to the Rows field. You drag
Price to the Values field.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 39
Your network contains a folder that has data files m various formats.
You need to identify how many files of each extension type are in the folder by using Query Editor. What should you do?

A. Create a query that uses a file source, and then use the Count Values command on the Transform tab.
B. Create a query that uses a folder source, and then use the Group By command on the Home tab.
C. Create a query that uses a file source, and then use the Group By command on the Home tab.
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D. Create a query that uses a folder source, and then use the Count Values command on the Transform tab.

Answer: B

NEW QUESTION 42
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The

format of the Workshop Manager column is always Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the
record is the current workshop manager.

 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You need to add a custom column to the workbook query for Workshops that contains the email address of the workshop manager. The format of the email
address is firstname.lastname@contoso.com.
How should you complete the query from Query Editor? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text.Replace([Workshop Manager]," ",".")&Contoso.com
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NEW QUESTION 45
You have the following data sample.

You need to create a PivotTable that presents the data as shown in the following table.

A. Create a PivotTabl
B. Add UnitPrice to the Rows area and add SalesAmount to the Values area.Right-click a cell value for UnitPrice and modify the Group settings.
C. Create a PivotTabl
D. Add SalesAmount to the Rows area and add UnitPrice to the Values area.Right-click a cell value for SalesAmount and modify the Group settings.
E. Create a PivotTabl
F. Add UnitPrice to the Rows area and add SalesAmount to the Values area.Right-click a cell value for SalesAmount and modify the Field Settings.
G. Create a PivotTabl
H. Add SalesAmount to the Rows area and add UnitPrice to the Values area.Right-click a cell value for UnitPrice and modify the Field Settings.

Answer: A

NEW QUESTION 47
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheet. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Your company has 100 product subcategories and more than 10,000 products.
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End of repeated scenario.
You need to create a measure named [Sales Monthly RT] that calculates a running total of [Sales] for each date within a month as shown in the following exhibit.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM([Sales],DATESMTD(DimDate[Date])) CALCULATE(SUM([Sales],DATESMTD(DimDate[Date])))

NEW QUESTION 52
You have an Excel workbook that displays two PivotCharts. One chart displays sales by month. The other chart displays sales by year.
You add a slicer for month.
You discover that when you select a month in the slicer, the data in the sales by year PivotChart changes. You need to prevent the slicer from affecting the sales
by year PivotChart.
What should you do?

A. Remove all the fields from the Filters area of the sales by month PivotChart.
B. Modify the Value Field Settings for the values of the sales by year PivotChart,
C. Modify the Report Connections of the slicer.
D. Remove all the fields from the Filters area of the sales by year PivotChart.

The Leader of IT Certification visit - https://www.certleader.com



100% Valid and Newest Version 70-779 Questions & Answers shared by Certleader
https://www.certleader.com/70-779-dumps.html (117 Q&As)

Answer: C

NEW QUESTION 57
You have a data model that has the following tables.

You create a PivotTable. The data displayed in the PivotTable is shown in the following table.

You need to ensure that the correct data is displayed. What should you do?

A. Modify the workbook connections
B. Configure the PivotTable Options
C. Modify the relationships
D. Refresh the data connection

Answer: C

NEW QUESTION 60
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have two Microsoft SQL Server database servers named Production1 and Test1. Production1 contains the same tables as Test1. but only a subset of the
data.
You add Test1 as a data source, and you select 10 tables. You configure several transformations. You need to connect the model to the tables in Production1. The
solution must maintain the existing
transformations.
Solution: You delete the existing queries, and then you add new data sources. Does this meet the goal?

A. yes
B. No

Answer: B

NEW QUESTION 65
From a workbook query, you import a table that has the following data.

You need to configure the table to appear as shown in the following table.

What should you do?

A. From the Format menu, click Trim.
B. From the Format menu, click Clean.
C. From the Split Column menu, click By Delimiter.
D. From the Extract menu, click Last Characters.

Answer: A
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NEW QUESTION 66
You have a table that contains sales data.
You need to create a Pivot Table that will display the sales by country as shown in the following exhibit.

What should you use to display the icons?

A. a measure
B. conditional formatting
C. data validation
D. a KPI

Answer: B

NEW QUESTION 69
You have the data model shown in the exhibit.

You need to create a hierarchy from DimProductSubcategory[ProduaSubcategoryName]andDimProduct[ProductName].
What should you do before you create the hierarchy?

A. Create a relationship between the table
B. To DimProductSubcategory, add a calculated column named ProductName that uses the
LOOKUPVALUE(DimProduct[ProductName],DimProduct[ProductKey],[ProductKey]) DAX formula.
C. To DimProduct, add a calculated column named ProductSubcategoryName that uses the LOOKUPVALUE(DimProductSubcategory
[ProductSubcategoryName],DimProductSubcategory[ProductCategoryKey],[ProductSubcategoryKey]) DAX formula.
D. Create a relationship between the table
E. To DimProduct, add a calculated column named ProductSubcategoryName that uses the RELATEDTABLE
(DimProductSubcategory[ProductSubcategoryName]) DAX formula.
F. To DimProduct, add a calculated column named ProductSubcategoryName that uses the VALUES(DimProductSubcategory[ProductSubcategoryName]) DAX
formula.

Answer: B

NEW QUESTION 72
Note: This question is part of a series of questions that use the same scenario, For your convenience is repeated in each question. Each question presents a
different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit.
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The data model is shown in the Data Model exhibit.

The tables in the model contain the following data:
DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue are two measures defined in DailyRepairs. Total Hours sums the Hours column, and Total
Revenue sums the Revenue column.
Workshops has a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always Firstname
Lastname, A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
Repair types has a list of all the repair types. Dates has a list of all the repair types.
Dates has a list of dates from 2015to 2018. End of repeated scenario.
You need to create a PivotChart that displays the month, the hours of the month, and the hours of the previous month, as shown in the following exhibit.

Which DAX formula should you use for the Total Hours Last Month measure? To answer, drag the appropriate values to the correct targets. Each value may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
IF (ISBLANK([Total Hours]), BLANK(), CALCUATE [Total Hours], DATESADD (tblDates[Date]),
-1,MONTH)))

NEW QUESTION 76
You have a table named AnnualSales. A sample of the data in AnnualSales is shown in the following table.
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You need to create a PivotTable as shown in the exhibit. (Click the Exhibit tab.)

How should you configure the Rows are and the Columns area in PivotTable Fields? To answer, drag the appropriate fields to the correct areas. Each field may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 79
You create a new workbook and add a table to a data model. The data is shown in the following table.
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You need to create a visualization as shown in the following exhibit.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
 Create a Pivot Table. Create a measure.
Create a Power View Report

NEW QUESTION 83
You have 12 sales reports stored in a folder as CSV files. Each report represents one month of sales data for a year. The reports have the same structure.
You need to analyze the entire year of sales data.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Click From CSV, and then select the first file in the folder. Edit the query, and then click Append Queries.
From the Power Pivot tab, click Add to Data Model.

NEW QUESTION 86
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a Power Pivot model that contains the following tables.
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There is a relationship between Products and ProductCategory.
You need to create a hierarchy in Products that contains ProductCategoryName and ProductName. Solution: You create a calculated column that uses the
RELATED DAX function
Does this meet the goal?

A. Yes
B. No

Answer: A

Explanation: 

References:
https://www.mssqltips.com/sqlservertip/2900/creating-hierarchies-in-powerpivot-for-excel/ https://msdn.microsoft.com/en-us/library/ee634202.aspx

NEW QUESTION 91
You have a measure named SalesGrowth that calculates the percent of sales growth. The measure uses the following formula.
([Total Sales Current Year] - [Total Sales Last Year]) / [Total Sales Last Year]
Total Sales Current Year is a measure that calculates the sales from the current calendar year. Total Sales Last Year is a measure that calculates the sales from
the previous calendar year.
You need to create a KPI that displays a red icon when the sales growth is less than last year. What should you use to define the target value?

A. an absolute value of 0
B. the Total Sales Current Year measure
C. an absolute value of 100
D. the Total Sales Last Year measure

Answer: D

NEW QUESTION 94
You have a query that retrieves the following data.

You need to configure the query to ensure that the data appears as shown in the following table.

What should you do?

A. From the Transform tab, use the sum function on the Vendor_ID column
B. Group by Vendor_ID and add a SUM aggregation
C. Unpivot the table on the Vendor_ID column
D. Pivot the table on the Vendor_ID column

Answer: B

NEW QUESTION 99
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have two Microsoft SQL Server database servers named Production1 and Test1. Production1 contains the same tables as Test1, but only a subset of the
data.
You add Test1 as a data source, and you select 10 tables. You configure several transformations. You need to connect the model to the tables in Production1. The
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solution must maintain the existing
transformations.
Solution: From Query Editor, you configure the Data source settings. Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 100
You have a workbook query that loads the following table

You pivot the table on the Key column by using Value as the values column, and you receive the results shown in the following table.

You need to ensure that the data appears as shown in the following table.

What should you do?

A. Change the aggregate value function of the pivot.
B. Select the ID column, and then click Unpivot Columns
C. Change the Data Type of the Value column.
D. Delete the Picoted Column ste
E. Select the Key column, and the click UnpivotColumns.

Answer: B

Explanation: 
References:
https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9ea1-49c1-9d95-f588221c7098

NEW QUESTION 105
You have a PivotChart template named Template1. You add a PivotChart to a worksheet.
You need to apply the template to the PivotChart. What should you do?

A. On the Design tab, click Change Chart Type.
B. On the Format tab, click Format Selection.
C. Right-click the chart and then click PivotChart Options.
D. Right-click the chart and then click Format Chart Area.

Answer: A

Explanation: 
 Click the chart
 On the Charts tab, under Change Chart Type, click Other, and then under Templates, click the chart template that you created.

https://stackoverflow.com/questions/17386777/how-to-apply-a-saved-chart-template-to-an-existing-chart

NEW QUESTION 109
You have a workbook query that retrieves data from a table named Users. Users contains a column named PhoneNumber. The following is a sample of the data in
PhoneNumber.
514 555 0169
1 (11) 500 555-0122
128 555-0148
819 555-0186
1-996-555-0192
+1 138-555-0156
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556-555-0192
You need to create a custom column that contains the data in PhoneNumber in the format of 999-999-9999. The following is a sample of the desired data.
514-555-0160
500-555-0122
128-555-0148
819-555-0186
996-555-0192
138-555-0156
556-555-0192
How should you complete the Query Editor formula? To answer, drag the appropriate values to the correct targets. Each value may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text.Replace(Text.End([Phone],12)," ","-")

NEW QUESTION 110
You create an Excel workbook named SalesResults.xlsx. You create a workbook query that connects to a Microsoft SQL Server Database and loads data to the
data model. You create a PivotTable and PivotChart.
You plane to share SalesResults.slsx to several users outside of your organization.
You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.
What should you do?

A. Modify the source of the query.
B. From Query Editor, open the Data Source Setting and delete the credentials.
C. Run the Document inspector.
D. Save the workbook as an Excel Binary Workbook (xlsx)

Answer: A

Explanation: 
References:
https://support.office.com/en-us/article/data-source-settings-power-query-9f24a631-f7eb-4729-88dd-6a4921380

NEW QUESTION 112
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You have a Power Pivot data model that contains a table named DimProduct DimProduct has seven columns named ProductKey, ProductLabel, ProductName,
ProductDescription, ProductSubCategoryKey, Manufacturer, and Brand.
Only the members of the product team use all the data in the DimProduct table.
You need to simplify the model for other users by hiding all the columns except ProductName. What should you do?

A. Create a perspective that has only the ProductName field from DimProduct selected.
B. Select all the columns in DimProduct except ProductName, right-click the columns, and then click Hide from Client Tools.
C. Edit the Default Field Set for DimProduct and add ProductName to the Default Field.
D. Edit the Table Behavior settings for DimProduct and add ProductName to the Default Label.

Answer: B

Explanation: 
https://support.office.com/en-us/article/hide-columns-and-tables-in-power-pivot-ddf5b1f2-2ed2-4bdb-8f78-6f94

NEW QUESTION 114
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You create a measure named Average Revenue Per Hour that calculates the average revenue per hour. You need to populate a cell in a worksheet to display the
Average Revenue Per Hour where Repair Type is
Engine.
Which Excel formula should you use?

A. =CUBEMEMBER(“ThisWorkbookDataModel”, “[DailyRepairs]. [Avg Revenue Per Hour]”,CUBEMEMBER (“ThisWorkbookDataModel”, “[Dimensions]. [Repair
Type]. [Engine]”))
B. =CUBEVALUE(“ThisWorkbookDataModel”, “[Measures]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”, “[Dimensions]. [Repair
Type]. [Engine]”))
C. =CUBEMEMBER(“ThisWorkbookDataModel”, “[DailyRepairs]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”, “[RepairTypes].
[Repair Type]. [Engine]”))
D. =CUBEVALUE(“ThisWorkbookDataModel”, “[Measures]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”, “[RepairTypes]. [Repair
Type]. [Engine]”))
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Answer: B

Explanation: 
 References:
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_cube_cubemember_function.htm

NEW QUESTION 116
You have a model that contains the following table named Sales.

You have a measure named TotalSales that calculates the sum of LineTotal.
You plan to create a PivotChart to display TotalSales for each category and the percent of total sales for each category as shown in the following exhibit.

How should you complete the DAX formula for the Percent measure? To answer, drag the appropriate fields to the correct areas. Each field may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
DIVIDE(TotalSales , CALCULATE(LineTotal, ALL(TotalSales), 0))

NEW QUESTION 119
You have 20 workbook queries that load 20 CSV files to a local computer.
You plan to send the workbook and the 20 CSV files to several users. The users will store the files in various location.
You need to ensure that the users can change the path to the CSV files in the queries as quickly as possible. What should you do from Query Editor?

A. Merge all the querie
B. Edit the source of the first query.
C. Create a paramete
D. Modify the source of each query to use the parameter.
E. For each query, create a new query that uses a referenc
F. Modify the source of each new query.
G. Append all the querie
H. Edit the source of the first query.

Answer: B

Explanation: 
https://www.howtoexcel.org/power-query/how-to-parameterize-your-power-query/ 

NEW QUESTION 122
You have two queries named Client and Invoices. A sample of Client is shown in the following table.

A sample of Invoices is shown in the following table.
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You need to create a new table that has the following information.

Which join kind should you use?

A. Inner
B. Left Outer
C. Right Anti
D. Left Anti

Answer: B

Explanation: 
https://www.excelguru.ca/blog/2015/12/16/merge-tables-using-outer-joins-in-power-query/

NEW QUESTION 123
You have a date column named [Date] in the format of mm-dd-yyyy.
You need to create a column named Quarter that displays the yearly quarter. A sample of the desired data is shown in the following table.

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
MONTH3
="Qtr " & ROUNDUP(MONTH([Date])/3,0)
="Qtr " & ROUNDUP(MONTH([Date])/3,0)
http://www.decisivedata.net/blog/quickly-create-week-month-quarter-and-year-fields-from-a-date-using-dax

NEW QUESTION 125
You have a data model in Excel.
You export the data and the data model into a dataset in the Microsoft Power BI service. What can you use to modify the data model that is published to the Power
BI service?

A. Microsoft Power BI Desktop
B. Excel and the Microsoft Power BI service
C. Excel only
D. the Microsoft Power BI service only

Answer: A

NEW QUESTION 130
You have a table in Power Pivot model that is loaded from a Microsoft SQL Server database.
The source table has four columns named ID, Price, Quantity, and Total. Total is derived by multiplying Price and Quantity. ID is a unique row identifier.
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You need to minimize the amount of memory used to load the mode. The solution must ensure that you can create visualizations based on Price, Quantity, and
Total.
What should you do?

A. Replace the Total column by using a measure.
B. Replace the Total column by using a calculated column.
C. From Query Editor, remove duplicate rows from the table.
D. Move the Total column to a lookup table.

Answer: A

Explanation: 

References:
https://support.office.com/en-us/article/create-a-memory-efficient-data-model-using-excel-and-the-power-pivot-

NEW QUESTION 132
You have a table named Sales that has three columns named OrderDate, OrderNumber, and SalesAmount. You need to create the PivotTable as shown in the
following table.

What should you use?

A. KPIs
B. sparklines
C. conditional formatting
D. banded rows

Answer: A

NEW QUESTION 136
......
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